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Information in this document refers to features available in Version 9 

of Pearl Softwareôs EchoƀSuite  software .  If you have purchased a 

module of Pearl Echo ƀSuite such a s Website ƀEcho or IM ƀEcho, please 

refer to http://www.pearlsw.com/products/comparison.html  for a list 

of features available with  your product  and described herein . 

Information in this document, including URL and other Internet web 

site references, is subject to chang e without notice.  Complying with 

all applicable copyright laws is the responsibility of the user.  Without 

limiting the rights under copyright, no part of this document may be 

reproduced or transmitted in any form without the express written 
consent of Pe arl Software, Inc.  

Pearl Software may have patents, patent applications, trademarks, 

copyrights, or other intellectual property rights covering subject matter 

in this document.  Except as expressly provided in any written license 

agreement from Pearl Softw are, the furnishing of this document does 

not give you any license to these patents, trademarks, copyrights, or 
other intellectual property.  

©200 9 Pearl Software, Inc.  All rights reserved.  

Pearl Software, Pearl Echo, EchoƀSuite , EchoƀFilters ,  Website ƀEcho, 

IMƀEcho and Mo bility Monitor  are either registered trademarks or 
trademarks of Pearl Software, Inc.  

The names of actual companies and products mentioned herein may 
be the trademarks of their respective owners.  
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Getting Started  

Welcome  

Introducing Pearl Echo , a comprehensive employee Inter net management 

package from Pearl Software. This premier tracking utility is the industry 

model for employee Internet access monitoring , filtering and control  and  

represents the most significant step available today in promoting responsible 

Internet use in  the workplace. Featuring Pearl Software's Mobility Monitor Ê 

technology, Pearl Echo  can effectively block inappropriate sites or set time 

restrictions on Internet use, regardless of where end -users reside. But what 

makes Pearl Echo  most unique is its intrinsic ability to monitor email, 

chat/instant messaging (IM) and news group postings and provide detailed 

access profiles to your network administrator. Pearl Echo 's Quick -Link  feature 

allows complete restoration of  all text from outbound and inbound 

communications. Pearl Echo  is a powerful applic ation, offering dynamic 

filtering, reporting and knowledge management functions to assist you in 
fulfilling your regulatory compliance and corporate governance requirements.  

About th is Userôs Guide  

The Pearl Echo  Userôs Guide describes Pearl Echo ôs features and functions as 

well as installation instructions and deployment strategies.  It is assumed that 

the reader  has a general understanding of  TCP/IP  networking concepts as well 

as Microsoft Windows® operating systems.  This guide is supplemental to 

Pearl Echoôs context sensitive help found in the Pearl Echo  Administration 
Console under the programôs Help menu. 

Pearl Echo  Architecture  

Pearl Echo ôs Employee Internet Management technology is based on an 

independent agent -server architecture.  By creating an i ndependent service, 

Pearl Echo  is not affected by high traffic volumes, how users access the 

Internet, or where your end users are physically located.  Pearl Echo ôs 

Employee Internet Management technology does not suffer from the 

performance and security p roblems of proxy monitoring solutions or from the 

overload and network dependency limitations of network sniffer solutions.  

Chapter  

1 
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The Pearl Echo  Server software runs as an independent service resident on 

one of your Windows Domain or Stand Alone Servers or on a  Windows 

Workstation.  The Internet access rules you create at the Pearl Echo  server 

are retrieved by your managed workstations through a secure, zero -
maintenance agent loaded on your Windows workstations.   

 

The same secure, zero -maintenance agent is res ponsible for sending --  or 

echoing --  actual or attempted Internet transactions back to the Pearl Echo  

server.  For ultimate efficiency, Internet access decisions are made at the 

client agent.  Data to be logged is first compressed by the agent before bein g 

sent back to the server on a path that is not dependent upon the path the 

workstation uses to access the Internet. The Pearl Echo  Workstation agent 

can be installed from the Pearl Echo  CD or automatically deployed by the 

Windows Installer files provided with Pearl Echo .  Once deployed, the Pearl 

Echo Workstation agent is self -updating ; the Workstation agent automatically 

gathers any updates or upgrades to Pearl Echo  when you update your Pearl 
Echo  server.  

With Pearl Echo 's Mobility Monitor Ê technology, managed workstations can 

be connected to your local area network, wide area network or completely 

detached from your private network.  The Pearl Echo  Workstation agent does 
its job no matter how or where your users connect to the Internet.  

Pearl Echo 's Employee Internet Management technology is extremely 

efficient, adds negligible network traffic and scales well due to its client -server 

architecture. Depending on the size of your network, loads can be balanced 

by running mul tiple Pearl Echo  services and pointing workstations to the 
appropriate server.  

Because Pearl Echo  runs as its own service, Echo has no dependences on 

legacy Proxy Servers or Firewalls .  
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Installing Pearl Echo  

Step 1: Echo Server Installation  

The Pearl Echo  Server Software can be installed on any supported Microsoft 

Windows platform whose IP address can be directly or indirectly (NAT) 

accessed by your managed workstations.  The Pearl Echo  Server Software is 

typically installed on a shared or dedicated Windows  Server platform but can 

even be installed on a Windows Workstation platform.  If you would like to set 

Internet access privileges based on  existing Active Directory User, Group  or 

Computer  names, you should install Pearl Echo  Server Software on a machine 

that is a member of your Domain.  The machine can be a Windows Domain 

Controller but need not be as the Pearl Echo  service is Domain -Aware and will 

automatically find your dat abase of Active Directory Users, Groups  and 

Computers 1.   If you have not yet mig rated to Active Directory, Pearl Echo  will 

automatically revert to the machineôs local list of Users and Groups.  Pearl 

Echo  will even accommodate smaller peer - to -peer installations and allow you 

to set Internet access profiles based on local login names  and computers .  

Regardless of your environment, there are no complicated setup steps for you 

to worry about.  The Pearl Echo  Server Software will automatically sense its 
environment and will configure itself accordingly.  

Follow these steps to install the E cho Administration Console and Monitoring 
Service:  

1.  Turn off Anti - virus & Spyware Removal applications prior to beginning 

installation.  

2.  Run setup.exe from the program installation folder or from the 

installation CD.   

3.  On the Startup screen, select the Serv er Setup Button.  

4.  The InstallShield Wizard will walk you through the initial installation 
procedures and prompt you to confirm the default installation settings.  

 
 

5.  Configure your antivirus and spyware removal applications to exclude 

from scanning the Pear l Echo program directory that you created in 

step 4 (e.g. c: \ Program Files \ Pearl Echo).  

6.  Launch the Pearl Echo Administration Console from the Programs 

section of the Windows Start button.  On Windows 7 and Vista, 

launch with elevated privileges by right cl icking on the Pearl 

Echo icon and selecting ñRun as administratorò. This is necessary 

even if you are an administrative user.  

                                                 
1 The Active Di rectory container(s) of your Users and Group members, resident on your domain 
computer(s), are mapped by the Echo Server.  It is recommended that the computer running the 
Pearl Echo  Server be explicitly added to the list of security objects for your User a nd Groups 
containers and the computer be given read permissions on those containers.  

 

R You can 

automate 
workstation 
installation using 
the included 
Windows Installer 
Service files.  

TIP 
Please note the destination location for your installatio n as you will need to exempt 
this folder from your antivirus & spyware removal applications.  
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7.  Enter your Company 

name and purchased 

serial number.  For 

demo installations  

a.  Select the Demo 

button to 

generate a trial 

activat ion code.  

b.  Enter  the  trial 

activation code 

into the first  

ñSerial Number :ò 

field and select 

Next.  

 

8.  Confirm or Enter your IP settings:   

a.  When prompted, confirm or enter the fixed  IP address of the 

Pearl Echo Server(IP address cannot be assigned via DHCP).  

b.  We recommend 

that you use the 

default Port 

number 58000.  

c.  Enter the Public 

IP or FQDN of the 

Pearl Echo Server 

if any of the 

managed end -

user machines 

will roam outside 

of your local 

network.  To 

manage users 

while they roam 

outside of your local network, y ou will need to configure your 

firewall to allow the roaming Pearl Echo Workstation agent to 

make a connection back to the Pearl Echo server. Please refer 

to the Advanced Installation chapter for additional information 

on managing your remote users.   

9.  Ente r a password to use when connecting to the Pearl Echo 

Administration Console.   

10.  Confirm that you wish to turn Pearl Echo Internet Management on 

Now.  This setting must be ON to begin the Pearl Echo Workstation 

Installation.  
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Step 2: Pearl Echo  Workstati on Installation  

The Pearl Echo  Server Software must be installed and running to install the 
Pearl Echo  workstation agent.  

Note: Before installing Pearl Echo  workstation components on Windows 95, 

verify that the workstation is running the latest version of  Microsoft's 

Winsock2 (available in the Utilities directory on the installation media).  

You can configure your managed workstations to  provide a Low, Medium or 

High level of tamper security  and prevention.  Set to Low, Pearl Echo will not 

prevent users from  accessing the Internet if Pearl Echo components have 

been altered  manually or by third party applications such as antispyware or 

antivirus software .  This is useful in  environments where security tools can 

not be configured to exempt Pearl Echo from being  scanned  or on 

workstations that have become unstable due to viruses , unauthorized 

applications or neglect.  With Tamper Security set  to Medium, Pearl Echo will 

block access to the Internet if Pearl Echo components have been altered.  This 

is the default s etting and is targeted to well -managed  environments .  When 

Tamper Security is set  to High, Pearl Echo will block access  to the Internet if 

Pearl Echo components  have been altered or  if  access to the Pearl Echo  

Service is not available on your server.  The Echo Service may be unavailable 

due to server maintenance, network problems, trial expiration, etc.  Please 

note : I f you are running an evaluation version of Pearl Echo , the Echo service 

will not be available once your trial period has expired.  After expi ration, a 

workstation with Tamper Security set to High will have Internet access 
interrupted.   

Follow these steps to manually install the Echo Workstation Agent:  

1.  Login to the workstation using an account with Administrator privileges.  

2.  Turn Off  all antiv irus, anti spyware and disk utility applications before 

beginning workstation installation.   

3.  Run setup.exe from the program installation folder  or from the installation 

CD.   

4.  Select  Workstation Setup  from the startup screen.  

5.  Enter the Echo Server FQDN or I P address entered in step 7a of the Echo 

Server Software Installation above.   (Note: FQDN is recommended in case 

you later move or upgrade your server to a new IP.)    

6.  Enter the Port number that you specified during the Echo Server 

Installation in Step 7b above.  

7.  If the workstation will roam outside of your private network, enter the 

Public IP or FQDN of your Echo Server entered in Step 7c above.   To 

manage users while they roam outside of your private network, you will 

need to configure your firewall to all ow the roaming Pearl Echo  

Workstation agent to make a connection back to the Pearl Echo  server. 

Please r efer to the Adva nced Installation  chapter for  details on  firewall 
settings.  
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8.  Select a Tamper Security level . The Medium  setting  is recommended 

during  evaluation.  

 

 

 

 

 

9.  The workstation will perform a test communication with the Pearl Echo  

Service and will display the results.  If a link can be established, reboot 
your Echo workstation to complete the installation.  

  

 

 

 

 
 

 

 

TIP 
Pearl Echo provides fail -safe operation if connectivity between a workstation and the 
Pearl Echo Server is interrupted. You can configure your managed work stations to have 
either full access (Low, Medium Security) or restricted access (High Security) to the 
Internet if the Pearl Echo Monitoring Service is not available due to maintenance, 
network problems, etc.  
 
If you are running an evaluation version of Pe arl Echo, the Echo Monitoring Service will 
not be available once your trial period has expired.  After expiration, Internet access will 
be interrupted on a workstation installed with High Tamper Security.   
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10.  Configure your antivi rus and anti spyware applications to exclude the 

Pearl Echo  Workstation program file directory folder.  You will also 

need to configure anti -virus and anti spyware applications to not disturb 

the Pearl Echo  Workstation Agent or its components.  R efer to this Guideôs 

Appendix for detailed guidelines.  

11.  Now that you have installed the Pearl Echo Workstation agent, begin 

browsing the Internet from this workstation or, if applicable, send IM 

and/or email messages from this workstation to test your initial setup.   

12.  Return to your Administration Machine and launch the Pearl Echo  

Administration Console to view the monitored activity.  You should see the 
workstationôs Internet activity presented in the Pearl Echo  Activity Log.  

 If you do not see the workstation activity, you might need to 

refresh your Pearl Echo  Server  activity log from the File menu or by 
selecting  the F5 key.  

13.  Congratulations!   You have successfully completed the initial installation.  

For detailed information on procedures and tips to help you continue a 

successful implementation using more advanced deployment options , 

please refer to the Advanced Installation  chapter of  this Userôs Guide. 

TIP 
During your initial installation, if your workstation does not communicate with your Pearl 
Echo server, the following are common issues that may need to be addressed:  
 

 Firewall. Firewall. Firewal l.  If a software firewall is on the Pearl Echo Server, 
allow the Pearl Echo processes echoComm.exe and emeraldshieldserver.exe. If a 
software firewall is on the managed Workstation, allow the Pearl Echo processes 
rnappp7.exe and updater7.exe. If a hardware firewall is installed between your 

Pearl Echo Server and managed Workstations, please be sure to make the 
firewall port assignments as detailed in Chapter 2 of the Pearl Echo Userôs 
Guide.  

 Make sure you have correctly identified and set your Administrat ion Machine's 
FIXED IP address in the Pearl Echo server software under the Options ->Network 
Configuration menu.  

 Make sure your Pearl Echo management is On in the Pearl Echo server software 
under the Security ->Set Security Status menu.  

 
Additional troublesh ooting tips are available in the Appendix of this User ôs Guide.  
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Upgrading from a Previous Version of Pearl Echo  

Pearl Echo  Version 9  will automatically gather your existing settings  from 

Pearl  Echo Version 5  or later . 

Server Upgrade  

Before installing and activating the Version 9 Server Software,  

1.  Login to the Administration Console of your previous version of Pearl Echo  

and turn Internet Management  OFF from the Set Security Status men u.  

2.  Make note of your network settings in the Options ->Network Settings 

menu.    
3.  Close the Pearl Echo  Administration C onsole .  

Version 8 Server Upgrade  

Upgrading from Version 8  should be acc omplished using a Pearl Echo 9  server 
patch.   

1.  Download and run the V ersion 9 Server patch from the Pearl Software 
website, www.pearlsoftware.com/echo9/updates.  

Version 7 or Earlier Server Upgrade  

Install and run  the full version of  Pearl Echo  Version 9 in a new program 

directory. Do not try to apply a Pearl Echo Server pat ch to Version 7  or 

earlier .  A link to the full product download is emailed during trial registration 

and order confirmation. When prompted, use the same IP and Port settings as 

your previous installation.  Your pervious versionôs profiles, lists, active  data  

and report settings will automatically be migrated to  your new installation.   

After you confirm migration of your previous versionôs settings, uninstall the 
previous version server software from Add/Remove Programs.  

Workstation Upgrade  

Previous version s of the Pearl Echo  Workstation software are fully compatible 

with the new Pearl Echo  9 Server.  It is recommended, however, that you 

upgrade your Pearl Echo  Workstation software in order to take advantage of 
the added benefits available in this latest ver sion.   

Version 7 and Version 8 Workstation Upgrade  

To automatically update your Pearl Echo Version 7 and Version 8 Workstation 

agents, download the Version 9 Workstation patch  from the Pearl Software 

website, www.pearlsoftware.com/echo 9/updates. P lace the  Version 9 

Workstation patch in the WS_Updates folder found in the directory where you 

installed the Pearl Echo Version 9 Server software.   The Pearl Echo Server will 

automatically deliver the patch to Pearl Echoôs zero-maintenance agent. After 
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delivery, t he self -updating agent will patch itself the next time the machine 
on which the agent resides is restarted.  

Version 6 or Earlier Workstation Upgrade  

If you are upgrading your Version 6 or earlier workstations to Version 9, y ou 

will need to uninstall your p revious version of the Pearl Echo  Workstation 

software before installing Pearl Echo  9 Workstation components.  This can be 

accomplished by removing the software from the Workstationôs Add/Remove 

Programs applet or automated with use of scripts provided by Pearl Software 

support.  Because the Pearl Echo  Workstation software is a secure 
installation, it cannot be removed with a Group Policy Object.  



P E A R L  E C H O  U S E R ô S G U I D E  

14  

Starting Pearl Echo  for the First Time  

When you run the Pearl Echo  Administration Console  for the first time:  

Step 1: Setup Wizard will ask you to register your name and serial 
number.  

1.  Enter your name as you would like it to appear on the Pearl Echo  startup 

welcome  screen.  

2.  Enter your product serial number exactly as provided with the distribution 

media or sales co nfirmation documentation. If you are evaluating Pearl 

Echo , enter the evaluation code in the Name field and leave the serial 

number blank.  Your evaluation code is provided  to you when you activate  

your trial software.  

Step 2: Setup Wizard will ask you t o confirm or enter your network 

settings.  

Setup Wizard will ask you to verify or enter the IP address of your server and 

a service port number. If you would like to monitor users that roam beyond 

the perimeter of your private network, enter the Public IP or FQDN of your 

Pearl Echo  Server.  

 

Note: For detailed information on configuring Pearl Echo  to work with Network 

Address Translation (NAT) or through a Firewall, please refer to Chapter 2, 
Advanced Installation.  

 

 
RYour Pearl Echo 

Server can be set 
to operate 
through a NAT or 
Firewall device.  
More on this in 
Chapter 2.  
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Step 3 : Setup Wizard will ask you to ent er and confirm your 
administrative password.  

Your password can be any combination of numbers and letters. Upper and 
lower case letters are not treated the same.  

Step 4 : Setup Wizard will ask you to enter e - mail settings.  

E-mail settings are used to send i nformative reports that you configure and 

schedule to be distributed in the Pearl Echo Report Manager.  These settings 
are also used if you have purchased premium support.  

Step 5 : Setup Wizard will ask you if you want to begin monitoring 
Internet activity.  

When Setup Wizard finishes, Pearl Echo  will start the Profile Wizard.   

 

The Profile Wizard will walk you through selecting Pearl Echo 's most common 

settings.  Any settings you make in the Profile Wizard can be changed later 

from within the Pearl Echo  Administration Console .   
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Uninstalling Pearl Echo 

Pearl Echo provides a secure uninstaller for the Pearl Echo Workstation Agent.  

To reduce visibility, a Pearl Echo entry does not exist in the Workstationôs Add 

Remove Programs window.  The Pearl Echo  Servic e is required to authenticate 

Pearl Echo  Workstation uninstall requests. The Pearl Echo  Service must be 

running to securely uninstall workstation components.   To run the Pearl Echo  

Service, set the Internet Management State to ñONò in the Pearl Echo  
Admini stration Console.  

To Uninstall Pearl Echo  Workstation Software  

1.  From the workstation taskbar, click on Start and select Run . 

2.  Enter ec7unins.exe and select OK.  

3.  Enter your Pearl Echo  password and follow the instructions as they appear 
on the screen.  

Pearl Ec ho  will log successful and unsuccessful attempts at uninstalling the 

Pearl Echo  Workstation software.  Pearl Echo  will also log when the 

Workstationôs network configuration has been altered. 

To Uninstall Pearl Echo  Server Software  

1.  Run the Pearl Echo  Admini stration Console . 

2.  From the Security Menu, select Set Security Status.  

3.  Turn the Pearl Echo  Management State  ñOFFò and exit Pearl Echo . 

4.  Select the Windows Control Panel.  

5.  Select  Add/Remove Programs.  

6.  From the Install/Uninstall tab, click on Pearl Echo . 
7.  Select  the Add/Remove button.  
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Advanced Installation  

Network Address Translation  

Pearl Echo  can be configured to work with Network Address Translation 

(NAT). Use this configuration if the NAT device provides IP and PORT 

translation between the internal Pearl Echo  Server and external or roaming 
Pearl Echo  Workstations.  

 

1.  Start the Pearl Echo  Administration Console.  

2.  From the Security Menu select Set Security Status.  

3.  Turn Pearl Echo  Internet Management OFF.  

4.  From the Options Menu select Network Settings.   

5.  Enter the External IP address or Fully Qualified Domain Name (FQDN) of 

the NAT device in the ñServer Public IP or FQDNò box. 

6.  From the Security Menu select Set Security Status.  
7.  Turn Pearl Echo  Internet Management ON.  

NOTE: A Fully Qualified Domain Name provid es greater flexibility if your 

server IP address changes due to server upgrade or network architecture 

changes.  

 

Chapter  

2 
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Firewall Settings  

Pearl Echo ôs Mobility MonitorÊ connects through  a Firewall device utilizing  a 

specified group of ports. Pearl Echo  worksta tions establish an initial 

connection with the Pearl Echo  Server on a Control Port (Server Port 

Number). Additional command and control communications occur on three 

supplemental IP ports.  The Server Port Number (e.g. 58000) and three 

additional IP ports (e.g. 58001, 58002 and 58003) will need to be opened for 
direct pass - thru on your Firewall device.  

Public IP: Server Port Number + 0   Private IP: Server Port Number + 0  

Public IP: Server Port Number + 1   Private IP: Server Port Number + 1  

Public IP: Serv er Port Number + 2    Private IP: Server Port Number + 2  

Public IP: Server Port Number + 3   Private IP: Server Port Number + 3  

Example:  
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The Pearl Echo  Monitoring Service residing on the Echo Server communicates 

with the Pearl Echo  Workstation Agent thro ugh a proprietary protocol.  

Connections to the Pearl Echo  Monitoring Service that donôt communicate with 
the Pearl Echo  protocol are dismissed.   

The Pearl Echo  Server Port Number setting is accessed from Network Settings 
in the Pearl Echo  Administration Console ôs Options Menu. 

Terminal/Citrix Server Setup  

Pearl Echo  is fully functional in a Terminal/Citrix Server environment.  To 

operate in a Terminal/Citrix Server environment, install  the Pearl Echo  Server 

Software as described in Pearl Echo  Server Insta llation  above, on any 

Windows platform other than your Terminal/Citrix Sever.   

If using Citrix, correct Session Reliability issues as detailed in Knowledge Base 

Article 14 (www.pearlsw.com/support/kbase). I nstall the Pearl Echo  

Workstation software on your  Terminal/Citrix server as detailed above in Pearl 

Echo Workstation Installation .  Once installed, each Terminal/Citrix desktop 

session will run its own instance of the Pearl Echo  Workstation agent and will 

be fully managed by settings you specify in the Pearl Echo  Administration 
Console . 

Pearl Echo  will also monitor each user's session, even if the session is run as 

a published  application. For more information on managing published 

applications, please refer to the online article, ñUsing Pearl Echo  to Mon itor 

Published Applications on Citrix and Windows Terminal Serverò located at 
www.pearlsw.com/support.  

Pearl Echo  has been optimized for a server -centric multi -user environment.  

The Pearl Echo  Agent is extremely efficient, has a small memory footprint and 

adds negligible network traffic.  To further optimize performance of your 

Terminal/Citrix sessions, it is recommended that you specify the applications 
you would li ke to manage using Pearl Echo . 

 

 

 

 

 

 

 

RAdministrators 

can d efine the 
applications to b e 
managed by Echo 
by selecting 

ñApplication 
Detectionò in the 
Options menu .  
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Automated Workstation Setup  

Pearl Echo  supports automating the Pearl Echo  Workstation installation using 

the Windows Installer Service. When you assign an application to a computer, 

the application installation is performed when it is safe to do so. Typically this 

happens when the computer starts so tha t there are no competing processes 

on the computer.   The following describes the steps necessary to install the 

Pearl Echo Workstation software using Microsoftôs Group Policy Objects.  For 

additional details on using GPO to deploy software applications, in cluding 

trouble -shooting tips , please refer to Microsoftôs server and online 
documentation.  

Preparation  

Remote Software Installation is performed in conjunction with your settings in 

the configuration file, servset.ini , and the Windows Installer package supplied 
with Pearl Echo .   

The first step is creating a network share, called a software distribution point, 

which contains the packages and the program and configuration files. Next 

you need to make sure that Domain Computers can read from the software 

distribution point and write to the target of the installation. Finally, you need 

to modify the configuration file, servset.ini , with settings that you entered 

during the Pearl Echo  Server software installation.  

1.  Create a shared directory that contains all  of the Pearl Echo  Workstation 

installation files.  Share the directory as echows  

2.  Assign the óReadô NTFS permission for óDomain Computersô on echows 

(Winlogon is the privileged agent that applies software installation policy 

when each computer starts.  Winlogon req uires read permissions to the 

source files to complete the installation).  

3.  Edit the file servset.ini in the new directory and specify the server IP and 

Port that you entered during the Pearl Echo  Server Software installation.  

In addition you will need to s pecify your Tamper Security configuration 

preference ï low, medium  or high .  If you have users that will roam 

outside of your private network, you can optionally enter the public 

address (FWIP) of your Pearl Echo  server.  

Example:  

[Echo 9.0 settings]  

IP=19 2.168.0.1  

FWIP=echoservername.mycompany.com  

Port=58000  
Configuration= medium  

Setting Group Policy  

Software Installation works in conjunction with Group Policy and Active 

Directory.  Installation is done on computer objects, not user objects.  You 

can instal l to all computers in your domain or to specified computers in a 

given organizational unit.  In order to ensure that the Pearl Echo  Workstation 
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software does not get installed on your Domain Controller(s), the Group 
Policy Object that is created should hav e the appropriate security filters set.  

1.  Open Active Directory Users and Computers from Administrative Tools.  

2.  In the console tree, right -click the domain or organizational unit that 

contains  the computers  for which you want to set Group Policy.  

3.  Click Proper ties , and then click the Group Policy  tab.  

4.  Click New  to create a new Group Policy object and rename the object 

echows_gpo .  

5.  Click Properties  of echows_gpo .  

6.  Click Security  

7.  Remove óAuthenticated Usersô from the ACL  

8.  Add óDomain Computersô to the ACL and assign  óReadô and óApply 

Group Policyô permissions.  

9.  Verify that óDomain Controllersô is not  part of the ACL.  

10.  Click OK  

To set the Software Installation Group Policy in the echows  Group Policy 

object:  

1.  Click Edit echows_gpo .  

2.  Double -click Computer Configuration.  

3.  Double -click Software Settings.  

4.  In the console tree, right -click Software Installation and select New  

Package .  

5.  Enter the UNC name of the Pearl Echo  Workstation installer file(e.g. 

\ \ servername \ echows \ Echo 7.0 Workstation.msi)  

6.  Select Assigned.  

If you prefer to mask the software title from appearing during installation on 

Domain Computers, you can edit the properties of the new Software 

Installation entry.  The next time a workstation in the domain starts, it will 

automatically install the Pearl Echo  Workstati on software and configure the 

installation to access the Pearl Echo  Server specified in serverset.ini .  

Important Note:  Because the Pearl Echo  Workstation software is a secure 

installation, it cannot be removed with Group Policy Object.  Removing the 

softwa re can only be ac complished from the Workstation  or automated with 
scripts provided by Pearl Software support.   
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Automated Workstation Setup using Logon Scripts  

Pearl Echo  supports automating the Pearl Echo  Workstation installation using 

Windows Logon Scr ipts. To silently deploy the Pearl Echo  Workstation agent:  

1.  Create a shared directory that contains all  of  the Pearl Echo  Workstation 

installation files.  Share the directory as echows  

2.  Create a blank file called firsttime.txt in the new directory.  

3.  Edit the file s ervset.ini in the new directory and specify the server IP and 

Port that you entered during the Pearl Echo  Server Software installation.  

In addition you will need to specify your Tamper Security configuration 

preference ï low, medium  or high .  If you have users that will roam 

outside of your private network, you can optionally enter the public 

address (FWIP) of your Pearl Echo  server.  

 

Example:  

[Echo 9.0 settings é]  

IP=192.168.0.1  

FWIP=echoservername.mycompany.com  

Port=58000  
Configuration= medium  

At login, t he workstation will need to run the command  

msiexec.exe /i ñ<path> \ Pearl Echo 7.0 Workstation.msi ò /q  

where <path> is the  file path to the new directory.  

The following is an example of running a silent install from a userôs login 
script. Installation is run one time for each machine.  

@echo off  

'Checking for first time on target machine  

if exist c: \ firsttime.txt goto vend  

copy \ \ servername \ echows \ firsttime.txt c: \ firsttime.txt  

msiexec .exe  /i " \ \ servername \ echows \ Pearl Echo 7.0 Workstation.msi" /q  
:vend  

Note 1: The user under which the script is run must have Administrator 

privilege on the machine.  

Note 2: The workstation installation modifies the machineôs network  settings.  

A forced reboot is included to ensure the stability of the workstation 

(processing  running before and after inst allation will have different network  

settings until reboot).  Though it is not recommended, you can suppress the 

forced reboot with the following command:  

msiexec.exe /i ñ<path>\ Pearl Echo 7.0 Workstation.msi ò /qn 
REBOOT=Reall ySuppress  
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Integration with Microsoft SQL Server  

Pearl Echo  stores monitored Internet activity in its native Microsoft xBase 

database format.  For installations with high volume monitoring loads and 

large storage requirements, Pearl Echo  can be  easily  configured to store 

monitored Internet activity to a Microsoft SQL Server (version 2000 or later).  

The Pearl Echo  Server Software can be loaded on the same server that is 

running Microsoft SQL Server or any other machine that resides in a trusted 

Domain.  D ata stored on Microsoft SQL Server can be viewed and reported 

upon from the Pearl Echo  Administration Console .  To configure Microsoft SQL 
Server:  

1.  Copy the Pearl Echo  database (echodb00000) files located in the Utilities 

directory of the product CD  or ins tallation folder  to your SQL Server.  

2.  Create a SQL Server  Authenticated  user called echouser with password 

echopassword.   

3.  Attach to the Pearl Echo  database by right clicking on Databases and 

selecting All Tasks ->Attach Database in the SQL Server Console . 

a.  SQL Server 2000:  While  attaching to the database, specify 

echouser as the database owner.  

b.  SQL Server 2005:  After  attaching to the datab ase, select  Users  

for the echodb00 000 database, add the username "echouser" with 

login name "echouser", and assign the rol e db_owner.  

4.  Create a network share named cache0000000000 and apply read and 

write permissions to the domain computer on which the Pearl Echo  Server 

software resides  (verify the Share has read and write access under both 

the Share Permissions and NTFS Secur ity tabs) .  This share will be the 
location where Pearl Echo  will store additional cached content .  

To configure the Pearl Echo  Server to store monitored Internet activity to the 

Echo database on Microsoft SQL Server, enter the Pearl Echo  Administration 

Console and select Data Source Selection from the Options menu.  S pecify 

the name of the Microsoft SQL server and the database (echodb00000) and 
table (echotab00000) where Pearl Echo  should log activity.  
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Feature Overview  

Pearl Echo  tracks Interne t activity by looking at content as it travels to and 

from a workstation computer via the computerôs built in Winsock networking 

components. This approach enables Pearl Echo  to run reliably and silently in 

the background. The only indication that Pearl Ech o is running is the display 

of an optional warning message on the Workstation  that can be configured in 
the Pearl Echo  Administration Console . 

Pearl Echo ôs Administration Console  allows you to customize how you monitor 

and manage access to Internet Web, Em ail, Chat, Instant Messaging, News 

and FTP.  Access Control Profiles are used to control the Intern et access of 

individual users,  groups of users  or computers .  If you install Pearl Echo  

Server Software on a machine in a Windows Domain, User names, Group 

names  and Computer names  are gathered from your Active Directory 

database. This enables seamless  administration by eliminating the need to 

maintain separate profile accounts in the Pearl Echo  Administration Console . 

Monitoring Employee Internet Access  

Pearl  Echo allows you to retrace nearly every step an Internet user makes, by 

creating a complete audit trail of Internet activity, including site visits , file 

t ransfers, news  group activity , chat, instant m essaging, and email. Pearl 

Echoôs Quick LinkÊ feature allows the password holder to automatically link 

back to the actual World Wide Web and FTP sites the user visited, or to 

restore the text of incoming and outgoing News, Email, Chat and Instant 

Messaging items. As a monitoring tool, Pearl Echo  watches Inter net activity 
and reports it back to you.  

Managing Employee Internet Access  

For managing Internet access, Pearl Echo  provides fully customizable Allow 

and Block Control lists that are categorized into Web sites, FTP resources, 

Email addresses, newsgroups an d chat/instant messaging. Internet Security 

control can be set to allow varying levels of access. Each segment of the 

Internet can be set independently with the default being set to allow and 

monitor all sites.  Within the Pearl Echo  Administration Console  you can 

create Internet access Profiles in order to set varying levels of restrictions 
based on existing Windows User , Group  and Computer  definitions . 

Chapter  
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Pearl Echo  can also be configured to block incoming and outgoing content 

based on a n administrator -defin ed set of keywords. The primary focus of this 

feature is to protect against the dissemination of private information. This 
feature can also be used to block content that contains offensive material.  

In addition to the above modes of control, Pearl Echo  inc ludes a set of 

categorized Echo ƀFiltersÊ based on an automatically updating database of 

Internet  domains.  Using Echo ƀFilters , you can provide access to Web content 

based on content type.  There are over 4 0 EchoƀFilter s categories from which 

to choose incl ude shopping, job search, adult, and web -mail portals to name 
a few.   

Pearl Echo  also supports the PICs rating standard. There are various rating 

systems that have been developed and are currently being used on the 

Internet. PICs rating systems attempt to  characterize the nature of Web 

pages and other Internet content. Pearl Echo ôs PICs rating support allows you 

to control access to Internet content that has been rated by the content 

provider. While this content is self - rated, there are various third party  

organizations that strive to audit the validity of the contentôs rating. 

Pearl Echo ôs comprehensive approach to managing employee Internet access 

provides you with the ability to customize access modes and immediately 
override and update blocked material.  

Pearl Echo  Security  

Pearl Echo  Server  

Pearl Echo  logs Internet activity to files on your Pearl Echo  server. Since Pearl 

Echo  runs as a network service, all Pearl Echo  server files and configuration 

settings are well protected by your server's built in sec urity. In order to 

function, t he Pearl Echo  server installation directory need not be accessible by 
users on your network.  

Pearl Echo  Workstation  

Pearl Echo  workstation files are protected by Pearl Echo ôs built in security.  

The workstation uninstall is p assword protected and file tampering will cause 

Internet access to be terminated  if Security Tampering is set to Medium or 

High during the Pearl Echo Workstation installation .  Additional security is 
provided via Windows ACL permissions on applicable Windo ws platforms.  
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Using Pearl Echo  

Signing In  

Each time you start the Pearl Echo  Administration Console , you will be 
prompted for your login password.  

 

After your password is confirmed, you will be presented with the most current 

copy  of the Pearl Echo  Activity Log. You can perform any file operation on 

your copy  of the log without altering the integrity of the original Pearl Echo  
log.   

The Pearl Echo  Administration Console supports an Administrative and User 

level log in.  The User Level password a llows users other than the 

administrator to view the Pearl Echo  Activity Log and run Pearl Echo  reports.  

All Pearl Echo  features are available in the User Level except features that 

control Pearl Echo  security configurations.  The Administrative Level log in 
allows access to all Pearl Echo  features and settings.  

Chapter  
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Viewing the Activity Log  

The Pearl Echo  Administration Console automatically displays a copy of 

monitored Internet activity in the Pearl Echo  Activity Log Window.  

 

The Pearl Echo  Activity Log pres ents Internet Activity by the following 
categories:  

Source:  The type of Internet activity being logged. This can be Web, Ftp, 

Email, News, Chat/Instant Messaging, or Web -Mail. Web -Chat and Instant 

Messaging are  logged as Chat.  

Site:  The address of the Int ernet activity being logged. This can be a Web or 

Ftp location. It can also be an Email address, News Group name, Chat 
channel or Instant Messaging ID.  

Subject:  The subject or title of the activity being logged. For Email and News 

this will be the text th at appears in the message subject line. For Web 

activity, the Web page title will appear here. This entry will remain blank for 
Ftp.  

Date:  The date and time of the Internet activity being logged.  

Control:  Displays the Pearl Echo  Control that has restricted  access to 

Internet content. Examples include Keywords, Ratings, Block List and Allow 
List.  

User:  The Microsoft WindowsÊ login name of the user being monitored.  

Computer:  The Wi ndows computer name associated with the computer being 

monitored.  
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MacID:  The Media Access Controller ID (MacID) of the monitored 

workstation.  The MacID is a unique ID associa ted with the network card 

within a workstation.  

Signatures:  Data verification is performed at the Pearl Echo  Workstation on 

all data sent to the Pearl Echo  Server.  Individual check -sums are performed 

on the logged record data (Signature - r) as well as asso ciated file attachments 
(Signature - f).  

Remote Administration  

Pearl Echo  configuration settings can be remotely administered with Remote 

Desktop, Terminal Services or any third party remote connection software.  

Pearl Echo  uses a global protection mechanis m to guard against access of the 
Pearl Echo  Administration Console  from simultaneous user sessions.  

Viewing Logged Email, News, Chat & IM  

Pearl Echo  monitor s and control s all Internet standard Email (Pop -

3/SMTP/IMAP/ GroupWise/ Web -Mail), NNTP News, and Chat /Instant 

Messaging (IRC, AIM, MSN  Messenger, Microsoft Messenger , Windows Live 

Messenger, GroupWise IM,  Yahoo!, ICQ and JavaÊ). Pearl Echo  also monitor s 

any Chat/Instant Messaging application that is based on the SIP protocol such 

as Microsoft Messenger for Communications Server.  To view the content of 
incoming and outgoing Email, News, IM, and Chat:  

1.  Sele ct the desired entry from the Pearl Echo  Log Window.  
2.  Click on the Text Button or Double click on the desired entry.  

You will be presented with the monitored text. Encoded attachments will also 

be referenced. You can decode and read any email and News atta chment by  

1.  Right click ing  on the desired entry from the Pearl Echo  Log Window.  
2.  Select ing  óDecode Attachmentsô from the shortcut menu.  
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3.  Selecting the destination folder in which to store the attachments.  

The original decoded attachments will be available in the directory you 

specify.  You will need the fileôs associated application or viewer to open or 
run the attachments.  

To capture the text of Email, Chat, IM, and News postings, select ñCache 

Textò from the Cache Control menu.  If you would like to log Email, News, 

Chat, and Instant Messaging activity without capturing content, select ñDo not 

cache Contentò from the Cache Control menu.   

 

If you would like Echo to log a transaction's associated encoded attachments, 

select ñCache Text & Encoded Attachmentsò from the Cache Control menu in 

the Pearl Echo  Administration Console .  Pearl Echo includes a built in 
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attachment decoder in order for you to view captured documents, spread 
sheets, images, etc.  

Quick -LinkÊ to Logged Sites  

You can use Pearl Echo ôs Quick Link feature to easily view the Web and FTP 

sites listed in your active Pearl Echo  Activity Log.  

1.  To browse all sites, click the  button on the active Pearl Echo  

Log Window. This will automatically start your default web browser with 

links generated from y our Pearl Echo  Activity Log.  

2.  To browse an individual site, double -click your mouse button on the log 

entry that you want to visit. You can also choose ñGo to URLò from the 

shortcut menu. Your default web browser will automatically start and 

access the site  of interest.  

3.  You can also generate a permanent copy of your web page by selecting 

the ñPublish Browser Pageéò item from the File Menu. This is useful if you 

would like to create an HTML version of your Pearl Echo  Window in order 

to provide a starting poin t for Internet users.  Use this when you've 
logged your own research and would like to share the sites with a group.  

Searching the Activity Log  

The Pearl Echo  Administration Console  provides the ability to quickly sort 

through the entries displayed in the active Pearl Echo  Log Window.   

In order to identify specific information, sorting can be done by keyword, 
date, user, computer, MacID, violations or Internet content type.  

The Keyword command in the Sort menu allows you to enter a word or 

phrase by which to search  the contents of the active Pearl Echo  Log Window 

and associated text attachments. You can include the words in the Current 

Profile's Words & Phrases List during a keyword sort by selecting ñSearch with 
items in Words & Phrases Listò in the keyword search screen.  
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Items in the Pearl Echo  Log Window and any associated attachments that 

contain instances of the words or phrases in the S earch  box or Words & 

Phrases List will be identified.  

Clearing the Activity Log  

The Pearl Echo  log file contains th e list of activity logged during all managed 

Internet sessions. The ñClear Activity Logò command in the Security menu is 

used to clear the contents of the secure Pearl Echo  log file.   

Clearing the activity log must occur from within the Pearl Echo  Adminis tration 
Console to maintain Pearl Echo ôs security. 
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Setting Pearl Echo  
Security Levels  

Turning Pearl Echo  Management On and Off  

You can turn the Pearl Echo  Internet Management service On and Off in the 

ñSet Security Statusò command of the Security menu.  

 

When the Pearl Echo  Management Service is On, Pearl Echo  is controlling 

Internet activity even after you exit the Pearl Echo  Administration Console 

and log off of the Pearl Echo  server.  

It is recommended that you not  start and stop the Pearl Echo  Service from 
your systemôs Services Console. 
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